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How to unZIP this 
 
Select Actions > Extract.  Choose a suitable directory (or root directory) in 
the "Extract to" field.  Check the box "Use folder names".  Extract. 
Directory "GoldData_v6.3" and various subdirectories will be created. 
 
 
How to Open the .CSV Files 
 
The extension ".csv" stands for "comma separated values".  The test data is 
stored in files with this extension in the lowest directories of 
GoldData_v6.3.  These files are formatted to open in GeoTrans, in Excel and 
in any text editor or word processor. 
 
• Text editors.  The .csv files are ASCII files without the tab character 

and should open immediately in Notepad (Windows), Wordpad (Windows), and 
Microsoft Word.  The data is neatly arranged in columns aligned by the 
decimal point.  This is the simplest and most direct way to view the file 
contents. 

 
• Excel.  To open a .csv file in Microsoft Excel, perform the familiar 

sequence: File > Open > (browse to file name).  Since CSV is an extension 
and format known to Excel, the shorter way is to point and double-click on 
the filename.  (This depends on some commonplace system settings).  In 
Excel, highlight the numerical data and perform: Format > Cells > Number > 
(decimal places = 6) > OK.  Adjust column widths to suit. 

 
• GeoTrans.  To open a .csv file in GeoTrans, perform File > Open > (Files 

of type = All files) > (browse to filename).  It should not be necessary 
to make any change to the file before using GeoTrans to convert the file 
to another coordinate system.  The file header provides the information 
required by GeoTrans to read and process the file. 

 
 
Themes 
 
With Release 6, there are three themes: (i) map projections, (ii) global 3D 
coordinate systems, and (iii) local 3-parameter datum transformations.  Each 
theme is a first-level subdirectory and within it, the tests are designed 
appropriately.  See the index file provided for each theme. 
 
 
References 
 
GeoTrans is the reference for the map projection tests, and the local three 
parameter datum transformation tests.  It is not the only software for whose 
validation these tests are intended, but it is the reference.  The meaning of 
the various parameters found in the headers, like "Latitude Origin" and 
"Scale Factor" is that specified by GeoTrans. 
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For the global 3D coordinate systems theme, GeoTrans is likewise a reference 
for the geodetic coordinate system and the rectangular coordinate system 
("Geocentric" in MSP GEOTRANS 3.0).   
 
For the two other coordinate systems in this theme, the definitions are found 
elsewhere as follows:  Spherical coordinates are defined by The Spatial 
Reference Model (ISO/IEC 18026) in "Table 5.10 -- Spherical CS" and by many 
texts in science and engineering.  Ellipsoidal coordinates are defined by 
Heiskanen & Mortiz, Physical Geodesy, Freeman & Co, 1967, Section 1-19, with 
choice of "beta" (reduced latitude) over "theta" (reduced co-latitude). 
 
 
How to run and compare results 
 
Within any lowest subdirectory like /map_proj/WGS84, any two CSV files 
represent the same points on the Earth (or specified ellipsoid), given in two 
different coordinate systems.  The coordinate system of each is specified in 
the header. 
 
To test your software against a pair of CSV files, direct it to read the 
numbers from one file, and provide it the equivalent of the header 
information from both files.  Compare results with the numbers from the other 
file. 
 
Lat_Lon.csv is the same information as Lon_Lat.csv and, except for the 
headers, is the same in each of the map_proj subdirectories. 
 
 
What to do when your software fails a test 
 
Developers interested in meeting the standard set by GeoTrans may benefit 
from these comments: 
 
• GeoTrans may also have failed the test.  If your software fails, or 

partially fails, and GeoTrans also fails in the same way, there is no 
criticism that your software is below the standard set by GeoTrans. 

 
• Download the latest version of GeoTrans from the NGA web-site at 

http://earth-info.nga.mil/GandG/, and make comparison runs with GeoTrans. 
 
• Read the release notes.  Some mention is made of tests that were outside 

the version of GeoTrans available at time of release.  A thorough report 
on GeoTrans performance is outside the scope of these instructions. 

 
 
Why the data is "Gold" 
 
The Gold Data provided herein is intended to lead, not follow, current 
practices, and to keep up with developments outside of NGA.  It is based on 
the accepted definitions by academia and industry of the coordinate systems 
considered. 
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List of Files 
 
A list of all the files is given in suggested logical order, with help files 
highlighted in red and ***.  (Produced by the DOS command “Dir */S/B/A-D” and 
sorted manually with Notepad.) 
 
GoldData_v6.3\Instructions.doc                    *** 
GoldData_v6.3\Release_Notes.doc                    *** 
GoldData_v6.3\GeoTrans_File_Format_Summary.doc               *** 
GoldData_v6.3\map_proj\map_proj_index.xls                  *** 
GoldData_v6.3\map_proj\Show_Lon_Lat_points.pdf               *** 
GoldData_v6.3\global_3D\global_3D_index.xls                  *** 
GoldData_v6.3\NGA_3parDT\NGA_3parDT_index.xls                *** 
GoldData_v6.3\global_3D\SRMmax\ellipsoidal_110.csv 
GoldData_v6.3\global_3D\SRMmax\geodetic_106.csv 
GoldData_v6.3\global_3D\SRMmax\geodetic_Lat_first_107.csv 
GoldData_v6.3\global_3D\SRMmax\rectangular_108.csv 
GoldData_v6.3\global_3D\SRMmax\spherical_109.csv 
GoldData_v6.3\global_3D\WGS84\ellipsoidal_105.csv 
GoldData_v6.3\global_3D\WGS84\geodetic_101.csv 
GoldData_v6.3\global_3D\WGS84\geodetic_Lat_first_102.csv 
GoldData_v6.3\global_3D\WGS84\rectangular_103.csv 
GoldData_v6.3\global_3D\WGS84\spherical_104.csv 
GoldData_v6.3\map_proj\Sphere\Lat_Lon.csv 
GoldData_v6.3\map_proj\Sphere\LCC_60.csv 
GoldData_v6.3\map_proj\Sphere\LCC_60a.csv 
GoldData_v6.3\map_proj\Sphere\LCC_61.csv 
GoldData_v6.3\map_proj\Sphere\LCC_62.csv 
GoldData_v6.3\map_proj\Sphere\LCC_62a.csv 
GoldData_v6.3\map_proj\Sphere\LCC_63.csv 
GoldData_v6.3\map_proj\Sphere\LCC_64.csv 
GoldData_v6.3\map_proj\Sphere\LCC_65.csv 
GoldData_v6.3\map_proj\Sphere\LCC_66.csv 
GoldData_v6.3\map_proj\Sphere\LCC_67.csv 
GoldData_v6.3\map_proj\Sphere\LCC_68.csv 
GoldData_v6.3\map_proj\Sphere\LCC_69.csv 
GoldData_v6.3\map_proj\Sphere\Lon_Lat.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_51.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_51a.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_52.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_53.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_54.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_54a.csv 
GoldData_v6.3\map_proj\Sphere\Mercator_54b.csv 
GoldData_v6.3\map_proj\Sphere\Ney_70.csv 
GoldData_v6.3\map_proj\Sphere\Ney_71.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_55.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_55a.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_55b.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_56.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_57.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_57a.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_57b.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_58.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_58a.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_59.csv 
GoldData_v6.3\map_proj\Sphere\PolarStereo_59a.csv 
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GoldData_v6.3\map_proj\Sphere\TransMerc_72.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_72a.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_73.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76a.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76b.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76c.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76d.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76e.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76f.csv 
GoldData_v6.3\map_proj\Sphere\TransMerc_76g.csv 
GoldData_v6.3\map_proj\SRMmax\Lat_Lon.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_37.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_37a.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_38.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_39.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_39a.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_40.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_41.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_42.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_43.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_44.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_45.csv 
GoldData_v6.3\map_proj\SRMmax\LCC_46.csv 
GoldData_v6.3\map_proj\SRMmax\Lon_Lat.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_28.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_28a.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_29.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_30.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_31.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_31a.csv 
GoldData_v6.3\map_proj\SRMmax\Mercator_31b.csv 
GoldData_v6.3\map_proj\SRMmax\Ney_47.csv 
GoldData_v6.3\map_proj\SRMmax\Ney_48.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_32.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_32a.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_32b.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_33.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_34.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_34a.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_34b.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_35.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_35a.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_36.csv 
GoldData_v6.3\map_proj\SRMmax\PolarStereo_36a.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_49.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_49a.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_50.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75a.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75b.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75c.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75d.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75e.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75f.csv 
GoldData_v6.3\map_proj\SRMmax\TransMerc_75g.csv 
GoldData_v6.3\map_proj\WGS84\Lat_Lon.csv 
GoldData_v6.3\map_proj\WGS84\LCC_14.csv 
GoldData_v6.3\map_proj\WGS84\LCC_14a.csv 
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GoldData_v6.3\map_proj\WGS84\LCC_15.csv 
GoldData_v6.3\map_proj\WGS84\LCC_16.csv 
GoldData_v6.3\map_proj\WGS84\LCC_16a.csv 
GoldData_v6.3\map_proj\WGS84\LCC_17.csv 
GoldData_v6.3\map_proj\WGS84\LCC_18.csv 
GoldData_v6.3\map_proj\WGS84\LCC_19.csv 
GoldData_v6.3\map_proj\WGS84\LCC_20.csv 
GoldData_v6.3\map_proj\WGS84\LCC_21.csv 
GoldData_v6.3\map_proj\WGS84\LCC_22.csv 
GoldData_v6.3\map_proj\WGS84\LCC_23.csv 
GoldData_v6.3\map_proj\WGS84\Lon_Lat.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_5.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_5a.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_6.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_7.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_8.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_8a.csv 
GoldData_v6.3\map_proj\WGS84\Mercator_8b.csv 
GoldData_v6.3\map_proj\WGS84\Ney_24.csv 
GoldData_v6.3\map_proj\WGS84\Ney_25.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_09.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_09a.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_09b.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_10.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_11.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_11a.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_11b.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_12.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_12a.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_13.csv 
GoldData_v6.3\map_proj\WGS84\PolarStereo_13a.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_26.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_26a.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_27.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74a.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74b.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74c.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74d.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74e.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74f.csv 
GoldData_v6.3\map_proj\WGS84\TransMerc_74g.csv 
GoldData_v6.3\NGA_3parDT\Set_A\Local_geodetic_201.csv 
GoldData_v6.3\NGA_3parDT\Set_A\Local_geodetic_201_format6p1.csv 
GoldData_v6.3\NGA_3parDT\Set_A\WGS84_geodetic_202.csv 
GoldData_v6.3\NGA_3parDT\Set_A\WGS84_geodetic_202_format6p1.csv 
GoldData_v6.3\NGA_3parDT\Set_B\Local_geodetic_203.csv 
GoldData_v6.3\NGA_3parDT\Set_B\Local_geodetic_203_format6p1.csv 
GoldData_v6.3\NGA_3parDT\Set_B\WGS84_geodetic_204.csv 
GoldData_v6.3\NGA_3parDT\Set_B\WGS84_geodetic_204_format6p1.csv 
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